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The best way to learn ESRI® ArcGIS® 3D Analyst™ is to use it. In the
exercises in this tutorial, you will:

• Use ArcCatalog™ to find and preview 3D data.

• Add data to ArcScene™.

• Set 3D properties for viewing data.

• Create new 3D feature data from 2D features and surfaces.

• Create new raster surface data from point data.

• Build a TIN surface from existing feature data.

• Make animations.

• Learn how to use ArcGlobe™ and manage its data content.

In order to use this tutorial, you need to have the 3D Analyst extension and
ArcGIS installed and have the tutorial data installed on a local or shared
network drive on your system. Ask your system administrator for the
correct path to the tutorial data if you do not find it at the default installation
path specified in the tutorial.
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2 ARCGIS 3D ANALYST TUTORIAL

Copying the tutorial data

First you will copy the tutorial data to a local drive. You will
use ArcCatalog to browse to and copy the data.

1. Click Start, point to Programs, point to ArcGIS, and click
ArcCatalog.

3. Right-click the 3DAnalyst folder and click Copy.

1

ArcCatalog lets you find and manage your data. The left
side of the ArcCatalog window is called the Catalog
tree; it gives you a bird’s-eye view of how your data is
organized and provides a hierarchical view of the
geographic data in your folders. The right side of the
Catalog window shows the contents of the selected
branch of the Catalog tree.

2. Click in the Location combo box and type the path to the
\arcgis\ArcTutor folder on the drive where the tutorial
data is installed. Press Enter.

The ArcTutor folder is now the selected branch of the
Catalog tree. You can see its contents in the Contents
tab.

4. Right-click the local drive where you want to place the
tutorial data and click Paste.

The folder is copied to your local drive. Now you’ll
make a folder connection to the 3DAnalyst folder in the
Catalog tree.

4

3

2
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ARCGIS 3D ANALYST TUTORIAL 3

5. Click the 3DAnalyst folder on your local drive and drag
it onto the top-level node, Catalog, of the Catalog tree.

There is now a folder connection in the Catalog for your
local copy of the tutorial data.

In the graphics illustrating this tutorial, the ArcCatalog
option to use a special folder icon for folders containing GIS
data is turned on. That is why the folder GISdata, in the
graphic above, looks different from the other folders. You
can turn this option on in ArcCatalog, in the Options dialog
box, on the General tab. ArcCatalog works faster when this
option is turned off, so it is off by default.

5
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4 ARCGIS 3D ANALYST TUTORIAL

Viewing a remotely sensed image draped over a terrain
surface can often lead to greater understanding of the
patterns in the image and how they relate to the shape of
the earth’s surface.

Imagine that you’re a geologist studying Death Valley,
California. You have collected a TIN that shows the terrain
and a satellite radar image that shows the roughness of the
land surface. The image is highly informative, but you can
add a dimension to your understanding by draping the image
over the terrain surface. Death Valley image data was
supplied courtesy of NASA/JPL/Caltech.

Turning on the 3D Analyst extension

You’ll need to enable the 3D Analyst extension.

1. Click Tools and click Extensions.

Exercise 1: Draping an image over a terrain surface

2. Check 3D Analyst.

3 Click Close.

Previewing 3D data in ArcCatalog

Before you drape the image, you’ll browse to the terrain
data and preview it in ArcCatalog.

1. Navigate to the 3DAnalyst folder connection in the
Catalog tree.

1

2

3
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ARCGIS 3D ANALYST TUTORIAL 5

2. Double-click 3DAnalyst.

3. Double-click Exercise1.

5. Click the Preview tab. You can preview your GIS data in
ArcCatalog. With 3D Analyst installed, you can also
preview some data in three dimensions.

6. Click the Preview dropdown arrow and click 3D View.

You see a folder called Data and a TIN layer called
Death Valley Terrain.

A layer is a shortcut to geographic data. It also stores
information about how the geographic data should be
drawn on a map or in a 3D scene.

4. Click Death Valley Terrain.

4 5

7. Right-click above the preview window and click 3D
View Tools.

7

6

2

3

6
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6 ARCGIS 3D ANALYST TUTORIAL

The preview becomes a 3D preview, and a new set of
tools appears on the 3D View Tools toolbar.

The data rotates around its center. The Navigate tool
also allows you to zoom in and out and pan across the
data, depending on the mouse button that you click while
dragging in the 3D preview.

9. Right-click on the 3D preview and drag down.

8

The Navigate tool is active when you first preview data
in 3D. You can see the names of tools by hovering the
pointer over the tool.

The Navigate tool allows you to rotate 3D data and
change the apparent viewer height by clicking and
dragging left and right and up and down, respectively, in
the 3D preview.

8. Click on the 3D preview and drag to the right. The pointer changes to the Zoom In/Out pointer, and the
view zooms in to the data.

10. Click the middle button—or both the right and left
buttons if you have a two-button mouse—and drag to
the right.

Q

9

Navigate

Zoom In/Out Pan
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ARCGIS 3D ANALYST TUTORIAL 7

The pointer changes to the Pan pointer, and the view
pans across the data.

11. Click the Identify button and click on the TIN.

The view returns to the full extent of the data.

The Identify Results window shows you the elevation,
slope, and aspect of the surface at the point you clicked.

12. Close the Identify Results window.

13. Click the Full Extent button.

Now you’ve examined the surface data and begun to learn
how to navigate in 3D. The next step is to start ArcScene
and add your radar image to a new scene.

Starting ArcScene and adding data

ArcScene is the 3D viewer for 3D Analyst. Although you
can preview 3D data in ArcCatalog, ArcScene allows you
to build up complex scenes with multiple sources of data.

1. Click the ArcScene button on the 3D View Tools toolbar.
R

E

Identify

ArcScene
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8 ARCGIS 3D ANALYST TUTORIAL

ArcScene starts. Note that many of the tools on the
ArcScene Standard toolbar are the same as the 3D
navigation tools that you see in ArcCatalog.

3. Click the Add Data button on the ArcScene Standard
toolbar.

3

4. Navigate to the Data folder for Exercise1.

2. Click the Death Valley Terrain layer in the Catalog tree
and drag it onto the right-hand side of the ArcScene
window, then release the mouse button.

The TIN is drawn in the new scene.

4
2
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ARCGIS 3D ANALYST TUTORIAL 9

5. Click dvim3.TIF.

6. Click Add.

7. Uncheck the Death Valley Terrain layer.

7

The image is added to the scene.

The image is drawn on a plane, with a base elevation
value of zero. You can see it above the Death Valley
terrain surface where the terrain is below 0 meters
elevation (sea level); it is hidden by the terrain surface
everywhere else.

Now you can see the whole image. The black areas are
parts of the image that contain no data and are a result
of previous processing to fit the image to the terrain.

You have added the image to the scene. Now you will
change the properties of the image layer so that the image
will be draped over the terrain surface.

Draping the image

While the surface texture information shown in the image is
a great source of information about the terrain, some
relationships between the surface texture and the shape of
the terrain will be apparent when you drape the image over
the terrain surface. In ArcScene, you can drape a layer—
containing a grid, image, or 2D features—over a surface (a
grid or TIN) by assigning the base heights of the layer from
the surface.

5

6
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10 ARCGIS 3D ANALYST TUTORIAL

1. Right-click dvim3.TIF in the ArcScene table of contents
and click Properties.

3. Click the option to Obtain heights for layer from surface.

Because the TIN is the only surface model in the scene,
it appears in the surface dropdown list.

4. Click OK.

1

1

The layer Properties dialog box appears. You can change
how a layer is drawn on a map or in a scene by setting
its properties.

2. Click the Base Heights tab. The image is draped over the terrain surface.

Now you will be able to navigate around the image and see
the relationship between surface texture, as shown by the
image colors, and the shape of the terrain.

Exploring the image

You will use the navigation tools on the ArcScene Tools
toolbar to explore the draped image.

1. Click the Zoom in button.

2

3

4

Ch02.pmd 07/17/2006, 11:34 AM10



ARCGIS 3D ANALYST TUTORIAL 11

2. Click and drag a rectangle around the middle of the
image.

4. Click on the scene and slowly drag up and to the left.

2

3

4

The scene zooms to the middle part of the image.

3. Click the Navigate button.

The scene rotates, and the view angle lowers, so it looks
as though you are looking down the valley, past the
higher land on the left side of the scene.

Elevated, rocky area

FloodplainAlluvial fan

Ch02.pmd 07/17/2006, 11:34 AM11



12 ARCGIS 3D ANALYST TUTORIAL

The Scene Properties dialog box lets you set properties
that are shared by all of the layers in the scene. These
include the vertical exaggeration, the background (sky)
color, the coordinate system and extent of the data, and
the way that the scene is illuminated (the position of the
light source relative to the surface).

2. Click the General tab.

2 3

4

3. Type “2” in the Vertical Exaggeration combo box.

4. Click OK.

The apparent height of the terrain is now doubled.

The elevated land is visibly rougher terrain than the flat
valley bottom. The surface texture—and therefore the
color, in the radar image—of this rocky area is different
than the fine sediment of the floodplain—the yellow and
black region in the valley bottom. The rocky area is also
a different texture from the gently sloping alluvial fan
that runs past it, down onto the valley floor.

Draping the radar image over the terrain surface allows you
to see the relationship between the general shape of the
land surface and the texture of the rocks and sediment that
make up the surface.

Exaggerating the terrain

The valley is a broad area, relative to the height of the
terrain, even though the mountains at the edge of the scene
are more than 2,000 meters above the valley floor. In order
to enhance the sense of depth in the scene, and to bring out
subtle features in the terrain, you will exaggerate the height
of the terrain.

1. Right-click Scene layers in the table of contents and
click Scene Properties.

Ch02.pmd 07/17/2006, 11:34 AM12



ARCGIS 3D ANALYST TUTORIAL 13

You can now clearly see how the alluvial fan spreads out
onto the valley floor, between the larger rocky area at
the center of the scene and the smaller rocky area in the
foreground at the left side of the scene.

1

1. Click File and click Save As.

You have added depth to the radar image, explored the
general relationship between the data in the image and the
terrain data, and enhanced the scene so that you can
perceive more subtle variations in the terrain.

Now that you’ve built the scene, you will save it so that you
can explore it later if you choose.

Saving the scene

Scenes, also called Scene Documents, are like maps. They
contain information about how the layers that are in the
scene should be rendered and where the data is located.

2. Navigate to the Exercise1 folder.

3. Type “Deathvalley”.

4. Click Save.

The scene will now be available for you to open later.

2

3

4
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14 ARCGIS 3D ANALYST TUTORIAL

Exercise 2: Visualizing contamination in an aquifer

Imagine that you work for a water district. The district is
aware of some areas where volatile organic compounds
(VOCs) have leaked over the years. Scientists from your
department have mapped some plumes of VOCs in the
aquifer, and you want to create a 3D scene to help officials
and the public visualize the extent of the problem.

Some of the data for the scene has already been assembled
in the Groundwater scene. You will modify the scene to
better communicate the problem.

VOC data was supplied courtesy of the San Gabriel Basin
Water Quality Authority.

Opening the Groundwater scene document

This scene document contains a TIN that shows the shape
of the contaminant plume, a raster that shows the
concentration of the contaminant, and two shapefiles that
show the locations of parcels and wells. You will drape the
concentration raster over the plume TIN, extrude the
building features and change their color, and extrude the
well features so that the wells that are most endangered by
the contamination may be more easily recognized.

1. In ArcScene, click File, then click Open.

3. Click Groundwater.sxd.

2. Navigate to the Exercise2 folder.

4. Click Open.

The Groundwater scene opens. You can see the four
layers in the table of contents.

Showing the volume and intensity of
contamination

You’ll drape the raster of VOC concentration over the TIN
of the contaminant plume surface to show the volume and
intensity of contamination in the aquifer.

1. Right-click congrd and click Properties.

1

4

3

1
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ARCGIS 3D ANALYST TUTORIAL 15

2. Click the Base Heights tab.

5. Click the Color Ramp dropdown arrow and click a red
color ramp for the raster.

6. Click OK.

2

3

3. Click the dropdown arrow and click plume to get the
heights from the plume TIN.

Now you will change the symbology of the raster to
show the intensity of the contamination.

4. Click the Symbology tab.

7. Uncheck plume in the table of contents.

7

4

5

6
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16 ARCGIS 3D ANALYST TUTORIAL

Now it is possible to see the shape of the plume and its
intensity in 3D.

Showing the relationship of the plume to wells

You can see that some of the wells are within the area of
the plume. However, it is difficult to see which wells are
most seriously affected because the contamination is more
widespread but less concentrated at greater depths.

You will extrude the well features based on their depth
attribute in order to see which wells intersect the plume.

1. Right-click wells and click Properties.

2. Click the Extrusion tab.

3. Click the Calculate Extrusion Expression button.

You will display the well points as vertical lines equal to
the depth of the well. This information is stored in the
WELL_DPTH field.

4. Click WELL_DPTH.

5. Click OK.

6. Click the dropdown arrow to apply the extrusion
expression by adding it to each feature’s base height.
The well depths are expressed as negative values, so
they’ll be extruded downward.

7. Click OK.

1

4

5

6

7

3

2
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ARCGIS 3D ANALYST TUTORIAL 17

You can see the places where the wells intersect, or are
close to, the plume. Now you will modify the scene to show
the priority of various facilities that have been targeted for
cleanup.

Showing the facilities with a high cleanup priority

Analysts in your department have ranked the facilities
according to the urgency of a cleanup at each location.
You’ll extrude the facilities into 3D columns and color code
them to emphasize those with a higher priority for cleanup.

1. Right-click facility and click Properties.

6. Click OK.

2. Click the Extrusion tab.

3. Click the Calculate Extrusion Expression button.

4. Click PRIORITY1.

5. Type “* 100”.

The expression you created appears in the Extrusion
value or expression box.

3

2

4

6
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18 ARCGIS 3D ANALYST TUTORIAL

7. Click the Symbology tab.

8. Click Quantities.

9. Click the Value dropdown list and click PRIORITY1.

78

9

Q

10. Click OK.

The facilities are now extruded in proportion to their
priority score. The scene now shows the shape and
intensity of the contamination, the wells in relationship to
the plume, and the facilities that need to be cleaned up
in order to prevent further pollution of the groundwater.

Now you’ll save your changes to the scene.

W

11. Click the Save button.
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ARCGIS 3D ANALYST TUTORIAL 19

Exercise 3: Visualizing soil contamination and thyroid cancer rates

In 1986, after the catastrophic accident at the Chernobyl
nuclear power plant in Ukraine, a large amount of
radioactive dust fell on Belarus. Since then, scientists have
studied the aftermath of the accident. One tool for exploring
the data is 3D visualization. In this exercise, you will create
two surfaces from point data collected in Belarus. One set
of points contains measurements of soil CS137
concentrations. CS137 is one of several radioactive isotopes
released by the accident. The other set of points shows the
rates of thyroid cancer, aggregated by district, with the
sample point placed near the district centers.

The CS137 contamination and thyroid cancer data was
supplied courtesy of the International Sakharov
Environmental University.

Viewing the point data

First, you will open the Chernobyl scene and view the point
data.

1. Click File and click Open.

The CS137 soil measurements are shown with small
point symbols, using a graduated color ramp to show the
intensity of the contamination. The districts’ thyroid
cancer rates are shown with larger symbols, using a
different color ramp.

Creating 3D point features

The soil CS137 samples are 2D points with some attributes.
One way to view 2D points in 3D is by setting an extrusion
expression, or a base height. You can also incorporate a
z-value into a feature’s geometry to allow it to be directly
viewed in 3D without the need to set a base height from a
surface or an attribute.

First, you’ll add the 3D Analyst toolbar to ArcScene.

2. Navigate to Exercise3 and click Chernobyl.

3. Click Open.

1

2

3
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20 ARCGIS 3D ANALYST TUTORIAL

1. Click View, point to Toolbars, and click 3D Analyst. 3. Click the Input Features dropdown list and click
Subsample_1994_CS137.

The 3D Analyst toolbar in ArcScene contains several 3D
analysis and data conversion tools. The ArcMap™
3D Analyst toolbar contains the same tools, plus several
additional tools that you can use in ArcMap.

Now you will create 3D point features from the soil
CS137 points.

2. Click 3D Analyst, point to Convert, and click Features
to 3D.

4. Click the Input Feature Attribute button, then click the
Input Feature Attribute dropdown list and click
CS137_CI_K.

5. Change the output feature name to CS137_3D.

6. Click OK.

The features are converted to 3D point features. However,
they still seem to be resting on a flat plane because the
CS137 concentration values range from 0 to 208.68, which
is small, relative to the horizontal extent of the data.

1

2

3

4

5

6

Ch02.pmd 07/17/2006, 11:34 AM20



ARCGIS 3D ANALYST TUTORIAL 21

Increasing the vertical exaggeration

You will exaggerate the scene to show the new points with
their height embedded in the feature geometry.

1. Click View and click Scene Properties.

3. Click Calculate From Extent.

4. Click OK.

5. Click the Full Extent button.

5

2. Click the General tab.

Now that you can see the new 3D points in the scene,
you can turn off the original CS137 sample point layer.

6. Uncheck the box in the table of contents beside
Subsample_1994_CS137 and click the minus sign beside
the box to hide the classification.

Extruding columns

Viewing points in 3D space is one way to investigate data.
Another way is to extrude points into columns. You will
extrude the thyroid cancer points into columns to compare
them to the contamination data.

1. Right-click ThyroidCancerRates and click Properties.

1

6

1

2

3

4
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22 ARCGIS 3D ANALYST TUTORIAL

2. Click the Extrusion tab. 6. Click OK on the Expression Builder dialog box.

7. Click OK on the Layer Properties dialog box.

Now the district centroid points are shown with columns
proportionate to the thyroid cancer rates. If you navigate
the scene you will see that the areas with the highest
contamination levels also tend to have high thyroid
cancer rates, although there are areas with lower CS137
contamination levels that also have high cancer rates.

Creating a surface from point sample data

You know what the soil concentrations of CS137 are at the
sample point locations, but you do not know what they are
at the locations between sample points. One way to derive
the information for locations between sample points is to
interpolate a raster surface from the point data. There are
many ways to interpolate such surfaces, which result in
different models of varying accuracy. In this exercise you
will interpolate a surface from the samples using the
Inverse Distance Weighted (IDW) interpolation technique.
IDW interpolation calculates a value for each cell in the
output raster from the values of the data points, with closer
points given more influence and distant points less
influence.

1. Click 3D Analyst, point to Interpolate to Raster, and click
Inverse Distance Weighted.

3. Click the Calculate Extrusion Expression button.

4. Click INCID1000 (the rate of cases per 1,000 persons).

Because the z-values of the phenomena that you are
comparing have different ranges, you will multiply the
cancer rate by 100 to bring the values into a range
similar to that of the CS137 measurements.

5. Type “* 100”.

1

4

6

5

2

3
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ARCGIS 3D ANALYST TUTORIAL 23

2. Click the Input points dropdown list and click
Subsample_1994_CS137.

6. Click Save.

7. Click OK.

3. Click the Z value field dropdown list and click
CS137_CI_K.

4. Click the Browse button.

5. Navigate to the Exercise3 folder and type
“CS137_IDW” in the Name field. ArcScene interpolates the surface and adds it to the scene.

2
3

4

5

6

7
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24 ARCGIS 3D ANALYST TUTORIAL

Viewing the interpolated surface

Now that the surface has been added to the scene, you can
see that there are two areas with very high concentrations
of CS137. You will view the surface in perspective, with a
new color ramp, to better see its shape.

1. Right-click CS137_IDW and click Properties.

4. Click the Base Heights tab.

1

2. Click the Symbology tab.

3. Click the Color Ramp dropdown arrow and click a new
color ramp.

5. Click Obtain heights for layer from surface.

6. Click OK.

7. Uncheck CS137_3D in the table of contents.

2

3

7

4

5

6

Ch02.pmd 07/17/2006, 11:34 AM24



ARCGIS 3D ANALYST TUTORIAL 25

Now you can see the interpolated surface of CS137
contamination, along with the thyroid cancer rate data.

3. Double-click INCID1000 in the Fields list.

Next, you will select the province centers with the
highest rates of thyroid cancer.

Selecting features by an attribute

Sometimes it is important to focus on a specific set of data
or specific features. You can select features in a scene by
their location, by their attributes, or by clicking them with
the Select Features tool. You will select the province
centers by attribute to find the locations with the highest
rates.

1. Click Selection and click Select By Attributes.

2. Click the Layer dropdown arrow and click
ThyroidCancerRates.

2

3

1
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26 ARCGIS 3D ANALYST TUTORIAL

4. Click the >= button.

They are drawn in light blue to indicate that they are
selected.

Viewing the attributes of features

You will investigate attributes of the selected locations and
find out how many cases of thyroid cancer occurred in
these districts.

1. Right-click ThyroidCancerRates and click Open
Attribute Table.

5. Type “0.5”.

6. Check the selection expression you’ve built.

7. Click Apply.

8. Click Close.

The province centers with thyroid cancer rates greater
than 0.5 cases per 1,000 are now selected in the scene.

4

6

7 8
1
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ARCGIS 3D ANALYST TUTORIAL 27

2. Click the Selected button. 4. Right-click CASES and click Statistics.

The table now shows only those features that you
selected.

3. Right-click CASES and click Sort Ascending.

The selected province centers are sorted according to
the number of cases.

2

3

The total number of cases in the selected set of
11 province centers is 176.

5. Close the Selection Statistics dialog box.

5

4
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28 ARCGIS 3D ANALYST TUTORIAL

6. Click the Navigate button and click on the scene.

You can work in ArcScene while the attribute table is
open.

7. Click the Save button.

7

In this exercise you have created 3D features, extruded
point features, and interpolated a raster surface from a set
of data points. You’ve compared the extruded vector data
to the surface data and explored the attributes of the vector
data.
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Exercise 4: Building a TIN to represent terrain

The town of Horse Cave, Kentucky, is situated above a
cave that once served as the source of drinking water and
hydroelectric power for the town. Unfortunately, the
groundwater that flows in the cave was polluted by
household and industrial waste dumped on the surface and
washed into sinkholes. Dye tracing studies and a three-
dimensional survey of the cave revealed the relationship
between the cave passages and the town and demonstrated
the connection between open surface dump sites and
contamination of the groundwater in the cave below.

Thanks to the development in 1989 of a new regional
sewage facility and the joint efforts of the Cave Research
Foundation and the American Cave Conservation
Association (ACCA), the groundwater is cleaner, and the
cave has been restored. It is now operated as a tour cave
and educational site by the ACCA.

Cave data was provided courtesy of the ACCA.

Viewing the cave and the landscape

First you will open the BuildTIN scene and view the cave
survey and some terrain data layers. You’ll use this terrain
data to create a TIN and drape some other layers on it to
visualize the relationship of the cave to the town.

1. Click File and click Open.

2. Navigate to the Exercise4 folder and double-click
BuildTIN.sxd.

The scene opens, and you can see the location of roads
and railroads, some sample elevation points, and a few
significant contour lines. In the table of contents, you
can see that some layers have been turned off.

1

2
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3. Check the box to show the Cavesurvey layer. 1. Click 3D Analyst, point to Create/Modify TIN, and click
Create TIN From Features.

4. Right-click Cavesurvey and click Zoom To Layer.

The cave survey data consists of PolylineZ features,
which are automatically drawn in 3D because they have
z-values embedded in their geometry. They appear
above the rest of the data because all of the other layers
are drawn with the default elevation of 0.

In the next steps you will build a TIN to provide the base
heights for the streets and a photo of the town.

Creating a TIN from point data

You have a point layer called vipoints point. This coverage
consists of points with an attribute called SPOT that
contains elevation values taken at these points. You’ll create
the TIN surface model from these points.

2. Check vipoints point.

The SPOT field name appears in the Height source
dropdown list, and the layer will be triangulated as mass
points.

3. Change the default path so that the new TIN will be
created in the Exercise 4\Terraindata\ folder.

4. Click OK.

1

3

4

2

4

3

Ch02.pmd 07/17/2006, 11:34 AM30



ARCGIS 3D ANALYST TUTORIAL 31

The TIN is created and added to the scene. Note that it is
drawn above the Cavesurvey layer; the elevation values in
the TIN define its base height.

Click on the Add button to open up the Add Renderer dialog
box. Click on the Face elevation with graduated color ramp
option and click Add. Click Dismiss to close the Add
Renderer dialog box and return to the Layer Properties
dialog box.

By default, the TIN is symbolized using a single color for
every face.

Right-click on the tin1 layer in the table of contents and
click Properties, then click the Symbology tab. You can see
there is a single renderer in place, titled Faces.

If the symbol for the highest elevation range is set to blue
instead of white, then right-click on any of the symbols and
click Flip Symbols. This will switch the order of the symbols
and render the highest points of the TIN as snow capped
peaks.
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1

2

3

4

Switch off the old single color renderer by checking off the
Faces checkbox in the list of renderers.

Click OK to close the Layer Properties dialog box.

While this TIN is a fairly good model of the surface, you
can make it more accurate by adding more features.

Adding features to a TIN

Now you will add hard and soft breaklines and a clip
polygon to the TIN. You’ll add the railroad features as soft
breaklines, so they’ll be represented on the surface but
won’t influence the shape of the surface. You’ll add the
brklines features as hard breaklines with elevation values to
refine the shape of the surface in areas that you’re most

interested in. Finally, you will add the smclp polygon as a
soft clip polygon to more smoothly define the edge of the
TIN.

1. Click 3D Analyst, point to Create/Modify TIN, and click
Add Feature to TIN.

2. Check railroad.

3. Click the Height source dropdown arrow and click
<none>.

4. Click the Triangulate as dropdown arrow and click soft
line.
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5. Check brklines.

The Add Features To TIN tool detects that there is an
ELEVATION field and uses it for the height source. You
will accept the default and triangulate them as hard
breaklines.

6. Check smclp.

7. Click the Height source dropdown arrow and click
<none>.

8. Click the Tag value field dropdown arrow and click
<none>.

You have defined the feature layers that you want to add
to your TIN and specified how they should be integrated
into the triangulation.

9. Click OK.

9

7

8

6

5

Ch02.pmd 07/17/2006, 11:34 AM33



34 ARCGIS 3D ANALYST TUTORIAL

The new features are added to the TIN.

After the next step you will see that the railroad follows
a bed that has been leveled somewhat relative to the
surface.

Setting feature base heights from the TIN

Now you will set the base heights for the road and railroad
features from the new TIN.

1. Right-click roads and click Properties.

2. Click the Base Heights tab.

3. Click Obtain heights for layer from surface.

4. Click the dropdown arrow and click tin1.

5. Click OK.

The road features are now draped over the TIN surface
that you created. Now you will drape the railroad
features over the surface.

1

23

5

4
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6. Right-click railroad and click Properties. The railroad features are now draped over the TIN
surface that you created.

Next you’ll drape the aerial photo over the TIN.

Setting raster base heights from the TIN

Including the aerial photo of the town in the scene makes
the relationship between the cave and the town much more
evident. You’ll drape the raster over the TIN and make it
partly transparent so that you’ll be able to see the cave
beneath the surface.

1. Right-click photo.tif and click Properties.

7. Click Obtain heights for layer from surface.

8. Click OK.

6

7

8
1
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2. Click the Base Heights tab.

3. Click Obtain heights for layer from surface.

4. Click the dropdown arrow and click tin1.

7. Click OK.

8. Check photo.tif.

Now the aerial photo is 30 percent transparent. You can see
large patches of the TIN over the photo because the TIN
and the photo have the same drawing priority. If you
wanted the TIN to be visible below the photo, you could
change its drawing priority to 10 (lowest) on the Rendering
tab of the TIN’s Layer Properties dialog box. You could
also offset the base height of the TIN or the photo by a
small amount.

Cleaning up the scene

To clean up the scene you’ll turn off some layers that are
no longer needed and make the cave line symbol larger.

1. Uncheck vipoints point.

2. Uncheck brklines.

3. Uncheck tin1.

4. Double-click the line symbol for the Cavesurvey layer.

5. Click the Display tab.

6. Type “30” in the Transparency text box.
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5. Type “5” in the Width box. Creating a profile of the terrain

The cave follows the valley floor orientation. To get an
understanding of the shape of the valley, you will create a
profile across the TIN. In order to create a profile, you
must first have a 3D line (feature or graphic). You will start
ArcMap, copy the TIN to the map, and digitize a line to
make your profile.

1. Click the Launch ArcMap button.

ArcMap starts.

2. Click OK.

6. Click OK.

Now you can see the three-dimensional passages of the
cave, symbolized by thick lines. The surface features
and the aerial photo provide context, so you can easily
see the relationship of the cave to the town.

5
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Now you will add the 3D Analyst toolbar to ArcMap. The
ArcMap 3D Analyst toolbar contains a few tools that do not
appear on the ArcScene 3D Analyst toolbar. Two of these
are the Interpolate Line tool and the Create Profile Graph
tool, which you will use to create your profile of the
surface.

3. Right-click on one of the ArcMap toolbars and click
3D Analyst.

The 3D Analyst toolbar appears.

4. Click Tools and click Extensions.

5. Check 3D Analyst.

6. Click Close.

The 3D Analyst extension is enabled.

7. Right-click tin1 in the ArcScene table of contents and
click Copy.
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8. Right-click Layers in the ArcMap table of contents and
click Paste Layer(s).

11. Click the upper-left corner of the TIN, drag the line to
the lower-right corner, and double-click to stop digitizing.

9. Check tin1 in the ArcMap table of contents to make the
layer visible.

10. Click the Interpolate Line button.

You can create a profile along a line with more than one
segment, but in this case you’ll just make one straight
line.

12. Click the Create Profile Graph button.

9
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The profile graph is created. You can see the graph on the layout of the map.

15. Click the Data View button to return to data view.

You can edit the title, subtitle, and other properties of the
graph; you can save, print, or export the graph; you can
copy it to the clipboard; and you can show the graph on
the layout. You can also simply close the graph.

13. Right-click the Profile Graph Title bar and click Add to
Layout.

14. Close the profile graph window.

Creating a line of sight on the terrain

Another way of understanding the terrain is to create a line
of sight. Lines of sight show what parts of a surface are
visible and what parts are hidden along a line from an
observer point to a target point.

1. Click the Create Line of Sight button.
R

T

Y
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2. Type “2” in the Observer offset text box. The line of sight is calculated. The green segments show
areas that are visible from the observer point; the red
segments are hidden from the observer.

The line of sight will be calculated to show what is
visible from the perspective of an observer two meters
tall, as the z units for this scene are meters.

3. Click on the south slope of the higher land in the upper-
right part of the TIN (the observer point), drag the line
to the lower-right part, and release the mouse button
(the target point).

4. Close the LineOfSight dialog box.
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Lines of sight, like other graphic lines, can be copied
from ArcMap to ArcScene. Now you will copy both the
lines you’ve created into the scene.

5. Click Edit and click Select All Elements.

7. Click Edit in ArcScene and click Paste.

The lines are pasted into the scene.

Both of the lines you created are selected.

6. Click Edit and click Copy.
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8. Click the Save button in ArcScene.

8

9. Click File in ArcMap and click Exit.

10. Click No.

Q

9
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Exercise 5: Working with animations in ArcScene

Imagine that you wish to create an animated sequence
showing the flight of an object over a landscape. You’ve
created a TIN and have draped images over it to show the
area. You also have some data pertaining to a strange
phenomenon that has been occurring in the region. You are
interested in displaying all the data in a dynamic way,
making an animation to tour points of interest, and showing
how you made the surface. You would also like to model
the phenomenon by moving a layer in the scene.

The tutorial data has already been assembled in the scene
document named Animation.sxd. You will use ArcScene
animation tools to effectively convey the points you want to
show.

Data was supplied courtesy of MassGIS, Commonwealth of
Massachusetts Executive Office of Environmental Affairs.

In this exercise, you will play an existing animation in the
scene document, Final Animation_A.sxd, and perform the
tasks typically used to create the animation.

Opening the Final Animation_A scene document

In this section, you will play an animation that demonstrates
some of the effects that you can create when you animate
a scene.

1. Click File in ArcScene and click Open.

2. Navigate to the Exercise5 folder and double-click Final
Animation_A.sxd.

2

This scene contains geographic information and recorded
special effects that have been combined to make an
animation.

1

Ch02.pmd 07/17/2006, 11:35 AM44



ARCGIS 3D ANALYST TUTORIAL 45

This animation shows the flight of a hypothetical
unidentified flying object (UFO) over the terrain.

3. Click the Play button.

Playing the scene’s animation

In order to view a scene’s animation, you need to turn on
the Animation toolbar.

1. Click View, point to Toolbars, and click Animation.

The Animation toolbar appears. Now you’ll play the
animation.

2. Click the Open Animation Controls button.

The animation plays, illustrating some of the effects you
can use in an animated scene.

In the next section you will work through the steps used
to make animations like this one.

3

2

1
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Opening the Animation scene document

1. Click File in ArcScene and click Open.

The scene contains an ortho photo, a scanned
topographic map, and other data you need to make your
animation.

2. Navigate to the Exercise 5 folder and double-click
Animation.sxd.

1

2
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For a camera keyframe, the object is the virtual camera
through which you view the scene. Navigating the scene
changes camera properties that determine its position.

ArcScene interpolates a camera path between
keyframes, so you’ll need to capture more views to
make a track that shows animation.

2. Right-click UFO.lyr and click Zoom To Layer.

In this section, you’ll use the animation tools to capture
keyframes, import tracks, play back your animations, and
save them to a scene document.

There are three types of keyframes that you can use to
build animations. The first is a camera keyframe. A camera
keyframe is a snapshot of the view you see in a scene. The
second, a layer keyframe, is a snapshot of a layer’s
properties. The third type is a scene keyframe, which stores
properties of a scene. In this section, you will create a
simple animation from a set of camera keyframes.

Capturing Perspective views as keyframes to
make an animation

The simplest way to make animations is by capturing views
to be stored as keyframes. The captured views are
snapshots of camera perspectives in a scene at a particular
time. The most fundamental element of an animation is a
keyframe. Keyframes are used as snapshots to interpolate
between in a track. You’ll create a set of keyframes to
make a camera track that will show an animation between
points of interest in your study area.

1. Click the Capture View button to create a camera
keyframe showing the full extent of the scene.

1

3

3. Click the Capture View button to create a camera
keyframe showing the UFO layer.

4. Click the Full Extent button to view all the data.

2
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8. Zoom to Littleville Lake.5. Click Zoom In on the Navigation toolbar and zoom to
Goss Heights, located near the center of your view.

5

6

7

8

9

Q

6. Click the Capture View button to create a camera
keyframe of Goss Heights.

7. Click the Full Extent button.

9. Click the Capture View button to capture a view of
Littleville Lake.

10. Click the Full Extent button.
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The captured views you just made are stored as a set of
camera keyframes in a camera track. When the track is
played, it shows a smooth animation between the
keyframes. Next, you’ll play your animation track.

Playing back your animation

You will play back animations using simple tools that
resemble the controls of a video cassette recorder (VCR).

1. Click the Open Animation Controls button.

1

3. Click the Play button.

3

2. Click the Animation toolbar and drag it to the lower-left
corner of the scene so it won’t block your view of the
tools or data.

An animation is played back by interpolating the camera
position between the keyframes in the track. In this
case, the animation shows a virtual tour through the
views you captured.

2
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Clearing an animation

If you want to start over, you can erase all the tracks you
created. In this section, you’ll remove the tracks you just
created so you can improve your animation.

1. Click Animation and click Clear Animation.

All animation tracks are removed from the scene.

Recording navigation

Another way to create a camera track for an animation is
to record in real time while you navigate in a scene. In this
section, you will record your view of the scene while you
navigate using the Fly tool.

1. Click the Fly tool on the navigation toolbar.

The Fly tool allows you to fly through your scenes.

1

2

2. Click the Record button to start recording your
navigation.

ArcScene begins recording as soon as you click the
Record button. If you don’t navigate right away, your
track will reflect this.

1
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Exercise 6: ArcGlobe basics

Navigating in ArcGlobe lets you explore your data and
teaches you how to accomplish fundamental tasks that
you’ll use later.

In this exercise, you’ll learn how to use the ArcGlobe
navigation tools and set properties that enhance your
viewing experience. This exercise assumes that you are
using ESRI-supplied default layers.

Examining the default layers in ArcGlobe

First, you’ll start ArcGlobe and learn what kind of data is
included by default.

1. Click the Start menu, point to Programs, then ArcGIS,
and click ArcGlobe.

ArcGlobe starts and its default layers are loaded. Notice
which layers are loaded in the globe by looking at the list
in the table of contents.

2. Click the Type tab in the table of contents.

ArcGlobe categorizes layers according to their type.
Layers are classified as elevation, draped, or floating.
Elevation layers are raster sources with height
information. They give the globe surface terrain. Draped
layers are features or rasters that use the elevation
layers as a source of their base heights. These layers
appear draped over the globe surface. Floating layers
are features or rasters that float independently of the
terrain surface. They appear offset from other layers,
either draped on discrete surfaces or set to some
constant elevation. Note the way the default layers are
categorized. Notice the default layers listed in the Type
page of the ArcGlobe table of contents. Both layers are
draped layers and, therefore, appear draped on the globe
surface.

Adding more layers

Default layers serve as a background to any data that you
want to add to ArcGlobe. Next you’ll add some local data
for the Las Vegas area.

1. Click the Add Data button.

1

2

1

Ch02.pmd 07/17/2006, 11:35 AM51



52 ARCGIS 3D ANALYST TUTORIAL

2. Navigate to the location of the Exercise 6 tutorial data
folder.

3. Click las_vegas_area.img, press Shift, and click
las_vegas_strip.img.

The multiple layers are selected.

4. Click Add.

The image layers are added to ArcGlobe as draped
layers. You’ll explore them later in this exercise.

Changing a layer’s drawing priority in the table of
contents

Draped layers that have overlapping extents need to have a
drawing priority set so one layer gets drawn on top of the
other. ArcGlobe makes some assumptions to accomplish
this, using criteria such as the cell size of a raster layer.
Occasionally, you’ll need to override the ArcGlobe default
drawing priorities. One way to do this is to change the order
of draped layers as they appear in the Type page of the
table of contents.

1. Click the Continents layer and drag it so it’s just above
the World Image layer.

A black line indicates where the layer will be placed.

2. Release the mouse pointer to drop the layer in its new
position.

The drawing priority is now set so las_vegas_area.img
and las_vegas_strip.img get drawn on top of the
Continents layer.
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1. Click the globe, slowly drag up and to the right, then
release the mouse pointer.

The globe rotates and the view angle lowers, so you gain
a different vantage point.

2. Right-click and drag down.

The pointer changes to the Zoom In/Out pointer, and the
view zooms in on the globe. To zoom out, right-click the
globe and drag up.

Navigating in Globe mode

ArcGlobe has two viewing modes: Globe and Surface.
Globe mode allows you to navigate your data in the realm
of the whole globe and sets the camera target to the center
of the globe. Surface mode lets you work with your data at
a lower elevation, allows additional perspective viewing
characteristics, and sets the camera target on the surface
of the globe. You’ll learn how to navigate in Globe mode
first, then in Surface mode.

The Navigate tool is active when you start ArcGlobe. You
can see the names of other tools on the Tools toolbar by
hovering the pointer over the tool.

Navigate

Zoom In/Out

1

2
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Using the Spin tools

1. Click the Spin Clockwise button.

The globe continuously spins clockwise around the
z-axis. You can change the speed at which it spins.

2. Click the Up arrow on the Speed text box to increase the
rate at which the globe spins.

Continued clicks will incrementally increase the spin
rate. You can also type in a value. Click the Down arrow
to decrease the rate.

3. Click the Stop button to stop the globe from spinning.

You can also press Esc to stop the globe from spinning.

3. Click Full Extent.

The globe displays at full extent.

Turning on the Spin toolbar

You can use the Spin toolbar to automatically spin the globe
clockwise or counterclockwise at any speed you wish.

1. Right-click the menu area and click Spin.

The Spin toolbar appears as an undocked toolbar.
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Finding places on the globe

If you have an Internet connection, you can find world
locations by using the ESRI Online Place Finder in the Find
dialog box.

1. Click the Find button.

2. Click Places.

3. Type “Las Vegas” in the Place Name text box.

4. Click Find.

5. Right-click Las Vegas, Nevada, United States, and click
Create Bookmark.

6. Right-click Las Vegas, Nevada, United States, and click
Zoom To.

1
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7. Click Cancel to close the Find dialog box.

The Find tool is an easy way of locating almost any place in
the world. Use it to locate points of interest, then use
bookmarks to save perspectives of these places.

Now that you’re zoomed close to the globe surface, you’ll
learn how to navigate in Surface mode.

Navigating in Surface mode

When you zoom in close to your data, you can switch to
Surface mode to make your navigation apply more correctly
to your new environment. Switching to Surface mode
places the camera target on the globe surface and gives
you a sense of 3D perspective while you navigate your
data.

1. Right-click las_vegas_strip.img in the table of contents
and click Zoom To Layer.

The display zooms to the Strip area of Las Vegas.

2. Click the Center on Target button.

3. Click the center of the Fountains of Bellagio.

The point you clicked is moved to the center of the
display. Centering on a target sets a target on the globe
surface and switches to Surface mode.
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4. Click Zoom to Target and click the central dome of the
Bellagio.

A new target is centered and the display is zoomed to it.

5. Click the Navigate button.

6. Click the bottom of the display and slowly drag up.

The globe rotates, and the viewing angle lowers. The
horizon becomes visible with a light blue background,
and you view the globe in a new perspective.

7. Click the Full Extent button to return the globe to its full
extent position.

Setting some preferences

You can modify the way ArcGlobe functions at both the
application and globe levels. First, you’ll explore some
application-level options.

1. Click Tools and click Options.

The Options dialog box is where you set application-level
preferences. The settings will be preserved in all
instances of ArcGlobe.
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2. Click General.

3. Check Animate viewer when using tools and commands.

This option will show smooth transitions from one view
to the next when you use tools that change your
perspective. This will be the standard behavior every
time you start ArcGlobe until you turn off the option.

4. Click OK.

3

4

2

5. Click View, click Bookmarks, and click Las Vegas.

The display moves to the Las Vegas bookmark in a
smooth, animated transition. Next, you’ll examine a
document-level option.

5
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Setting a document-level option

1. Double-click Globe layers.

2. Click the Background tab.

3. Click the Sky color dropdown arrow and click a color of
the morning or evening sky.
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Sky color is the color of the background when you zoom
in close to your globe as defined by the lower limit of the
transition zone.

4. Click OK.

If you switch to Surface mode and lower the viewing
angle, you’ll notice the background color changing to the
color you indicated.

In this exercise you learned how to differentiate between
ArcGlobe layer types, navigate in Globe and Surface
modes, find places, and set some application and globe
properties. Now that you’ve learned some fundamentals,
you can begin to explore other areas of ArcGlobe. In the
next exercise, you’ll learn how to use data as different layer
categories.

4
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ArcGlobe classifies layers into three types to help you
manage them: elevation, draped, and floating. In this
exercise, you’ll learn how to use the classifications to help
layers provide the right information to your documents. This
exercise assumes that you are using ESRI-supplied default
layers.

Adding elevation layers

Elevation layers provide height information to the globe
surface. You’ll use rasters with height source information to
provide topography to the globe surface, making it a globe
terrain.

1. Click the Start menu, point to Programs, then ArcGIS,
and click ArcGlobe.

ArcGlobe starts, and its default layers are loaded.

2. Click the Type tab in the table of contents to show the
default layer classifications.

Exercise 7: ArcGlobe layer classification

3

2

1

3. Right-click Globe layers, point to Add Data, and click
Add elevation data.

This indicates that you want to add a specific type of
data to that layer category.

4. Navigate to the location of the Exercise7 folder.

5. Select sw_usa_grid.

6. Click Add.
4

5

6
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The raster is added to the elevation category and will be
used as a source of elevation for the globe surface.

Adding draped layers

Draped layers are placed on the globe surface and use any
elevation data present to show base heights. Next, you’ll
add images that will be draped on the globe terrain you
created.

1. Right-click Globe layers, point to Add Data, and click
Add draped data.

Layers you now add will be draped on the globe terrain.

2. Click angelus oaks.tif, press Ctrl, and click
socal_mmosaic.sid.

Both layers are selected.

3. Click Add.

4. Right-click angelus oaks.tif and click Zoom To Layer.

The display zooms to the extent of the layer. A few
moments will pass before the layer is shown at full
resolution as the on-demand cache is built. Once the
cache is built, you’ll be able to revisit the area and
display the layer quickly.

The Angelus Oaks imagery appears washed out due to the
Continents layer being drawn with a higher drawing priority.
Next, you’ll learn how to change the drawing priority of a
draped layer.

2

3

1

4
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Changing the drawing priority of a layer in the
table of contents

Draped layers that have overlapping extents need to have a
drawing priority set so one layer gets drawn on top of the
other. ArcGlobe makes some assumptions to accomplish
this, using criteria such as the cell size of a raster layer.
Occasionally, you’ll need to override the ArcGlobe default
drawing priorities. One way to do this is to change the order
of draped layers as they appear in the Type page of the
table of contents.

1. Click the Continents layer and drag it so it’s just above
the World Image layer.

A black line indicates where the layer will be placed.

2. Release the mouse pointer to drop the layer in its new
position.

The drawing priority is now set so angelus oaks.tif and
socal_mmosaic.sid are drawn on top of the Continents
layer.

1

Setting a target to initiate Surface mode

1. Press Ctrl and click the middle of the display.

You’ve initiated Surface mode and set a target at the
location on the globe surface where you clicked.

1

2
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Adding floating layers

Floating layers are layers that float independently of the
globe surface. Next, you’ll add a raster as a floating layer
and set it to elevations not connected with the globe
surface.

1. Click Globe layers, point to Add Data, and click Add
floating data.

2. Click o3_99x10k.

o3_99x10k is a raster showing average annual ozone
concentration for 1999 in California.

3. Click Add.

The layer is added to the floating category.

1

2

3

2

3

2. Click the bottom of the display and slowly drag up.

The globe terrain you created becomes discernible as
you investigate the imagery you added.

3. Click the Full Extent button to return the display to the
original view.
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Setting elevation properties of floating layers

1. Right-click o3_99x10k and click Properties.

2. Click the Elevation tab.

3. Click Elevation values provided by this layer in the Layer
floats independent of the globe surface, draped on
dropdown menu.

1

4. Type “5000” in the Add a constant elevation offset in
meters text box.

5. Click Symbology.

6. Select the red to blue color ramp in the Color Ramp
dropdown menu.

2

3

4

Ch02.pmd 07/17/2006, 11:35 AM65



66 ARCGIS 3D ANALYST TUTORIAL

7. Check Invert.

This inverts the color ramp so that high values will be
displayed as red, low values as blue.

8. Click OK.

You’ve set the raster to use its own values as a source
of base heights, offset those heights 5,000 meters from
the globe surface, and symbolized the concentration
values with color. Next you’ll take a look at how this
appears in the display and set a vertical exaggeration to
accentuate the elevation.

1

5

6

7

8

Setting a vertical exaggeration factor for floating
layers

1. Right-click o3_99x10k and click Zoom To Layer.

The layer is displayed in the view.

2. Click the Navigation Mode button to change the mode to
Surface navigation.

2
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3. Click the bottom of the display and slowly drag the
mouse pointer up.

This allows you to see the effect of changing the vertical
exaggeration.

4. Double-click Globe layers.

5. Click the General tab.

6. Select or type a value of “10” in the Vertical
Exaggeration Of floating layers dropdown menu.

3

4

5

6

7

The floating layer will be exaggerated by a factor of 10.

7. Click OK.
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Examine the floating layer you created. You’ll see a 3D
raster showing average ozone concentrations in
California in 1999. The layer floats above the state of
California and is a surface that is different from the
terrain below.

In this exercise, you learned how to differentiate layer types
in ArcGlobe, saw the effect they have on the globe, and set
properties to improve their display. Explore Exercise7.3dd
globe document in the Exercise7 folder to discover
additional ways to enhance your globe documents. The
document contains layers saved with custom settings,
bookmarks, globe lighting, and animation tracks.
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A terrain dataset is a multiresolution TIN-based surface
derived from measurements stored in one or more feature
classes in a geodatabase.

In this exercise, you will use geoprocessing tools to load
surface data into a geodatabase, construct a terrain from
them, and use the terrain inside ArcMap and ArcGlobe.

Loading surface feature data into a geodatabase

In this scenario, you have LIDAR points and
photogrammetric breaklines stored in ASCII text files.
You’ll use them to construct a terrain. To accomplish this,
you need to import them into feature classes that reside in a
feature dataset. The terrain will be made at the same
location, next to its source data.

You’ve been provided a file geodatabase with a feature
dataset. It contains two polygon feature classes. One is for
lakes, the other to delineate the study area. What you need
to do first is import the ASCII points and lines.

1. Start ArcCatalog and make sure the 3D Analyst
extension is enabled via the Tools>Extensions dialog
box.

2. Browse to the terrain geodatabase and open the
topography feature dataset.

3. In the ArcToolbox window, choose the
3D Analyst Tools >Conversion>From File>
ASCII 3D to Feature Class tool.

Next you’ll convert points from a simple text file in XYZ
format into a multipoint feature class. These points only
define surface geometry. All that’s recorded for them are x,
y, and z. There’s one point per line, and the coordinates are
separated by spaces. Since there is no attribution associated
with these points, dedicating a database row for each is
wasteful and inefficient. Instead, you’ll combine them into
multipoints. A multipoint can store many points per shape or
row, saving storage space and improving read-write
performance.

Exercise 8: Creating and using a terrain dataset
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4. Open the ASCII 3D to Feature Class tool, make sure the
Browse for drop down list is set to Files, click the
Browse button, and choose the masspoints.xyz file as
input. Set the Input File Format to XYZ, name the output
feature class topo_mass_points and save it inside the
topography feature dataset. Set the Output Feature
Class Type to MULTIPOINT and the Average Point
Spacing to 10 then click OK.

The point spacing represents the average distance between
measurement points. Sometimes this is referred to as
nominal point spacing. This is given in the xy units of the
data.

The average point spacing option is only available when the
Output Feature Class Type parameter is set to
MULTIPOINT. It facilitates the clustering of points so that
each output multipoint is made from points that are
relatively close to one another.

In the next step, you’ll use the same tool to import
breaklines. Breaklines are linear features, such as roads
and water body shorelines, that need to be represented on
the surface. These are provided in the 3-D GENERATE
format; an ASCII format similar to XYZ but more
appropriate for line and polygon data. You can find a
detailed description of the format in the help. To find it, click
the Learn more about link located at the top of the help
page for the ASCII 3D to Feature Class tool.
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5. Open the ASCII 3D To Feature Class tool again. Choose
breaklines.lin as input and set the Input File Format to
GENERATE. Name the output feature class
topo_break_lines and locate it inside the topography
feature dataset. Set the Output Feature Class Type to
POLYLINE and click OK.

Now you’ve loaded the mass points and breaklines from
which a terrain will be built. The points came in XYZ
format, the lines in 3-D GENERATE format. Both are
ASCII formats for simple 3-D data and are read using the
same tool, ASCII 3D to Feature Class.

If you need to process a large collection of LIDAR points,
consider using the LAS format instead of XYZ. LAS is an
industry-standard format for LIDAR data. It’s more
efficient because it’s binary. It also has more information
stored in the file about the data. There’s a separate tool to
import LAS format files, LAS to Multipoint, that’s located in
the same toolset as the ASCII 3D to Feature Class tool.

Building a terrain from features

Use the Terrain wizard in ArcCatalog to define and build a
terrain.

1. In ArcCatalog right-click the topography feature dataset
and select New>Terrain from the context menu.
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Terrains are located in feature datasets. Terrains, and the
feature classes used to build them, must reside at the same
location. One benefit of using the feature dataset as a
container is that it ensures all the data used to build a terrain
has the same spatial reference. In an SDE database, it’s
also the organizational level at which data gets registered as
versioned for editing.

2. Accept the default name for the terrain. Click the Select
All button to check on all the feature classes. Then set
the Approximate point spacing to 10.

3. Click Next and indicate how each feature class will
contribute to the terrain. Click the Advanced button to
expand the column list. Use the same values as shown in
the graphic below.

Since the mass points and breaklines have z-values, which
will be used to define the terrain surface, the height source
for them is set to Shape. This means that z comes from the
shape geometry.

The topo_clip_poly feature class contains a 2D polygon. It
defines the horizontal extent of the surface and minimizes
interpolation artifacts around the surface perimeter. Clip
polygons work best when they’re smaller than the extent of
the data that is being used to provide z-values.

The water polygons are represented by 2D geometry but
have the height attribute SPOT. Each polygon can have its
own height, but that height is constant. For lakes, this is fine,
since they’re flat. With this data, there are no
measurements inside the lake boundaries that contradict the
lake SPOT values, so you can add the boundaries as
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Using these settings, the full resolution data is used in map
displays up to a scale of 1:2,500. Between display scales of
1:2,500 and 1:10,000, only the data necessary to achieve an
approximate vertical tolerance of 1.0, relative to the
full-resolution data, is used. Between 1:10,000 and 1:25,000,
a tolerance of 2.5 is used. Between 1:25,000 and 1:50,000, a
tolerance of 5 is used. For any scale smaller than that, a
tolerance of 10 is used.

Tolerances and scales used to define a terrain pyramid need
to be specified based on application requirements. One
approach is to mimic the accuracy requirements of a
contour map series. A generally accepted rule is that
contours should be accurate to within one-half of their
interval. For example, if a 1:24,000 scale map within your
study area uses a 5-foot contour interval, then the vertical
accuracy should be 2.5 units RMSE. Base the pyramid on
the scales and contour intervals appropriate for a map
series of the terrain.

breaklines; otherwise, they’d be added as replace polygons
to ensure their areas get flattened.

Everything but the breaklines are used for the terrain’s
overview representation. The overview is a generalized
representation of the terrain, similar to a vector-based
thumbnail. The breaklines are too detailed for this, but all
the other information is needed to produce a reasonable
looking overview.

On the next panel, you’ll define the pyramid for the terrain.
Terrain pyramids are used to create multi-resolution
surfaces. They’re similar to raster pyramids in concept
(that is, coarser pyramids are used for display at smaller
scales to improve display performance), but there are
differences. The most significant are that they’re composed
of vector-based measurements, their construction is based
on some measure of vertical accuracy, and they can be
used for analysis as well as display.

Terrain pyramids are defined using two factors: z-tolerance
and reference scale. The z-tolerance of an individual
pyramid level represents its approximate vertical accuracy
relative to the full resolution data. The reference scale of a
pyramid level defines the display scale at which it becomes
active.

4. Click Next to define the terrain pyramid levels. Click
Add four times, then manually reset the values for
Z Tolerance and Maximum Scale. Use the values
specified in the following graphic.
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While breakline vertices are used where needed through all
pyramid levels, the actual line enforcement can be
restricted to occur in a subset of these levels. For example,
road curbsides need not be enforced as triangle edges in a
terrain at scales smaller than 1:24,000. You control
enforcement via the Pyramid Bounds dialog box.

5. Click the Advanced Bounds Setting button to open the
Pyramid Bounds dialog box.

6. Set the Max Z Tolerance for the topo_break_lines
feature class to 1. Accept the defaults for the others.

In the dialog box, z-tolerances indicate at which pyramid
levels the enforcement is to take place. Using the given
values, the breaklines will be enforced for pyramid levels
with z-tolerances >= 0 and <= 1.0. This translates into the
breaklines being enforced only at scales larger than
1:10,000. The water and clip polygons are enforced through
all scales. This ensures the data boundary is always correct
and water bodies remain flat.

8. Click Next to reach the summary panel. Review your
settings. Click Finish to initiate the terrain build process.
This will take less than five minutes.

When the terrain build process is complete, the new terrain
is added to the Catalog Tree inside the feature dataset. You
can right-click this to get properties. You can also preview
the terrain in ArcCatalog.

7. Click OK to dismiss the Pyramid Bounds dialog.
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Viewing a terrain in ArcMap

Viewing a terrain in ArcMap is similar to viewing other data
types. There’s a terrain layer that you can turn on and off in
the table of contents (TOC). It has a Layer Properties
dialog to control display parameters. The Symbology tab on
this dialog is identical to TIN layers.

1. Start ArcMap.

2. Click the Add Data button.

3. Browse to topography_Terrain, add it to the map, then
make sure its visibility is turned on.

The terrain will retrieve measurements from the database
for the pyramid level associated with the current display
scale. The measurements are triangulated on the fly and
drawn to the screen. When going from a coarser pyramid
levels to more detailed levels, only the additional
measurements needed to get to the higher-detail pyramid
level are retrieved and added to the triangulation.

4. Zoom in on the display. Note how the vertical tolerance
associated with the current display is listed in the map’s
Table of Contents.

5. Zoom to the full extent of the layer. Note that Overview
Terrain is listed in the Table of Contents.

The terrain overview is the coarsest representation of the
terrain. It’s coarser than the lowest level of detail (LOD)
pyramid specified when the terrain was defined. The
overview is used by default when the layer is zoomed out to
full extent or beyond. This is used to speed up rendering.
Use of the overview representation can be turned on and
off from the Display tab of the terrain’s Layer Properties
dialog. You can also apply a point limit from this tab.

The use of a limit tells the terrain layer to downgrade its
display resolution if the current environment (that is, display
extent, scale, and pyramid definition) would require too
many measurement points. This helps maintain display
performance at the cost of not always honoring the terrain’s
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original pyramid display definition. When the resolution has
been downgraded, an asterisk is displayed next to the
terrain layer’s name in the TOC. By default, a point limit of
800000 is used.

6. Open the terrain’s Layer Properties dialog and click the
Display tab.

7. Change the point limit from 800000 to 125000 and click
OK.

8. From the map display, zoom in and out, then pan around.

The display should be consistently fast because the layer is
adjusting which pyramid levels gets used to keep the point
count below the 125000 limit.

Using the interactive surface analysis tools in
ArcMap

1. Make sure the 3D Analyst extension is enabled by
clicking its check box in the Tools>Extensions dialog.

2. Add the 3D Analyst toolbar from the View>Tools menu
if it’s not already displayed. The terrain is displayed in
the Layer combo box on the toolbar.

If you aren’t zoomed in far enough, the tools on the toolbar
are disabled. By default, they’re only enabled when the
terrain is displayed at full resolution. Based on how the
terrain’s pyramid was defined, this will occur at display
scales of 1:2,500 or larger.

You can enable the tools at lower resolutions from the
Analysis tab of the terrain’s Layer Properties dialog. When
you enable the tools at LODs lower than full resolution, the
accuracy is also decreased. Interactive tools always
operate at the current display resolution. This is useful if the
full-resolution terrain is oversampled for the requirements of
the analysis.

Ch02.pmd 07/17/2006, 11:35 AM76



ARCGIS 3D ANALYST TUTORIAL 77

3. Open the terrain’s Layer Properties dialog and, on the
Analysis tab, set the enabling resolution to 1.0.

4. Zoom in on the terrain until the display scale is larger
than 1:10,000. The tools should now be enabled.

5. Use the Create Line of Sight tool to see how it works on
the terrain.

6. Use the Interpolate Line tool. The resulting graphic line
will automatically be selected. A selected 3D polyline
enables the Create Profile Graph tool.

7. Execute the Create Profile Graph tool to graph the 3D
line.

Rasterize a terrain using a geoprocessing tool

Terrains can be rasterized based on any extent, cell size,
and vertical tolerance. You can choose between linear and
natural neighbor interpolators. The latter generally produces
higher quality results but at the expense of processing time.
Rasterization is performed using the Terrain to Raster
geoprocessing tool.

1. Open the Terrain to Raster tool. It’s located in the 3D
Analyst Tools>Conversion>From Terrain toolset.

2. Choose the terrain in the Input Terrain combo box. Set
the other values to match the graphic below.
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Keeping the Output Data Type as FLOAT will preserve
vertical precision. Changing the interpolation Method to
NATURAL_NEIGHBORS will take a little longer than
LINEAR but it adds some smoothness everywhere except
across hard breaklines where sharp discontinuities are
supposed to occur. Setting an explicit Sampling Distance
lets you know exactly what the output cell size will be. The
pyramid resolution represents the z-tolerance of the desired
pyramid level. In this terrain, the pyramid level with a
resolution of 1.0 has the breaklines enabled. This surface
will be somewhat generalized relative to the full-resolution
data but not by much, and this process will run faster
because it’s using a thinned version of the data.

3. Click OK to execute the tool.

To see the morphology of the derived raster surface,
generate a hillshade image:

1. Open the 3D Analyst Tools>Raster Surface>Hillshade
tool.

2. Specify the raster created by the Terrain To Raster tool
as input.

3. Click OK to execute the tool, and examine the resulting
hillshade layer.

Using a terrain as an elevation layer in ArcGlobe

Terrains can be used in ArcGlobe as elevation layers,
contributing to the definition of the globe surface.

1. Start ArcGlobe.

2. Add the terrain as an elevation layer.

3. Add the rasterized terrain and hillshade as draped layers.

4. Place the rasterized terrain on top of the hillshade on the
Type tab of the TOC.
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5. Symbolize the elevation raster  using an elevation color
ramp and assign about 50 percent transparency via the
Effects toolbar.

For best quality display, you can do several things. Go to the
Cache tab on the terrain’s Layer Properties dialog and
uncheck the option to compress to 16 bits. This will
eliminate the possibility of the surface geometry looking
stair stepped when zoomed in very close. You can also set
both the draped layers to use bilinear renderers. These will
draw a smoother picture. Also, the hillshade raster should
not use any stretch. The default using standard deviations is
not appropriate for this data.

As an alternative to viewing draped rasters derived from
the terrain, you can add the terrain directly as a draped
layer. To do this, open the TOC context menu, click Add
Data>Add Draped Data, then choose the terrain.
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